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ProVal version 2.27 December 2007 

ProVal version 2.27 introduces new tools for data editing and screening, the ability to vary mortality by 

pre/post-commencement, the introduction of core projection sample lives, additional flexibility in Canadian 

Solvency assumptions, and gain/loss analysis for periods longer than a year.  You’ll find details about these and 

other enhancements below. 

 

Census Data 

 Spreadsheet Edit now 

lets you perform any 

database operation 

without leaving the data 

editor (e.g., import data, 

print data, frequency 

tables). 

In addition, you can: 

o Undo (and redo) 

manual edits 

o Copy & paste (not 

just within ProVal, 

but also back and 

forth from Excel) 

o Interactively add and 

delete records and 

fields 

o Find specific values 

within a field 

o View records in 

rows (for multiple 

records) or columns 

(for a single record) 

o Sort records and 

fields, optionally 

freezing the first n 

fields (e.g., Name, 

SSN, and 

BirthDate). 

o Easily save and load custom views from the 

style library. 

o And more… 

 Manual edits are now included in a database’s 

change history, including before and after values 

(e.g., record #5’s BirthDate changed from 

1/1/1970 to 11/7/1980 by Jane Smith on …). 

 A new Screen Data command finds potential 

errors and warnings in your data.  A robust set of 

automatic checks are supplied along with the 

ability to create Custom Screening Tests.  This 

renders obsolete the commands: Compare 

Database Files, Screening Tests, Screen Data for 

Errors, Generate Error Report, and Correct 

Errors. 

 

See Data Screening, page 6 

 A new Condense Duplicates command lets you 

condense multiple records into a single record. 
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Mortality 

 Pre/post-commencement mortality tables are 

now available.  This is useful for proposed IRS 

2008 mortality as well as 0 pre-commencement 

mortality.   

 

 Four new tables have been added to the 

Mortality Rates library.  

o IRS 2008 Static Mortality Table 

o IRS 2008 Generational Mortality Table 

o IRS 2008 Combined Static Mortality 

o UP-1994 Projected to 2015 with Projection 

Scale AA (useful for Canadian Solvency 

Liability) 

 In Valuation and Projection Assumptions, active 

and inactive mortality can now vary by coded 

database field or calendar year, similar to the 

current functionality for other active decrements.  

Note that choosing <rates by calendar year> 

does not create an assumption change in a 

forecast. 

 Age by Year of Birth mortality tables are now 

available.  These are useful for generational 

mortality schemes which don’t utilize a 

projection scale (as found in Germany, Belgium, 

France, etc.). 

Canadian Registered Pension Plans 

 For solvency liability calculations, you can now 

assume, in one run: 

o Transfer value interest that varies by 

duration (as opposed to by calendar year), 

eliminating the need for a workaround when 

forecasting. 

o Immediate and deferred annuity purchase 

interest rates (separate from the transfer 

value interest rate) for all inactives and 

actives older than a specified age. 

o Mortality rates for both transfer value and 

annuity purchase (separate from the funding 

assumption).  For new valuation 

assumptions, solvency mortality defaults to 

“UP-1994 Projected to 2015 with Projection 

Scale AA” (see “Four New Tables…” above 

under “Mortality”). 

o Zero pre-commencement mortality (using a 

pre/post-commencement mortality table – as 

described above under “Mortality”). 

See Canadian Solvency Liability, page 19 

 Gain / Loss Analysis can now be run over 

multiple-year periods (e.g., 3 years).  Please see 

“Gain / Loss Analysis” on page 4 for details. 

Pension Plans 

 The interest rate assumption for lump sum 

factors in valuation assumptions can now vary 

by duration from decrement (or by duration from 

valuation date, as before), and be input as either 

spot rates or forward rates. 

 

 Deferral, temporary, and certain periods for 

active pension payment forms can now be 

specified by a table.  For example, a benefit 

might be immediate (deferral period of 0) if a 

participant has at least 10 years of service, or 

otherwise be deferred to age 65 (deferral period 

of 65 minus age at decrement). 

 

Forecasting 

 Sample lives are now available in core 

projections, making it possible to check details 

about emerging inactives, new entrants, and plan 

amendments like never before. 
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See Core Projection Sample Lives, page 11 

 A new #ENTRYYEAR benefit formula operator 

(and accrual basis operator) returns the year of 

entry for new entrants (e.g., 2010).  This makes 

it possible to vary the benefit formula for new 

entrants hired before and after a future date, as 

in 

#IF #ENTRYYEAR<2010 #THEN 

  FinalAvgBft 

#ELSE 

  CashBal/LSFactor 

#ENDIF 

 The Efficient Frontier can now find mixes which 

optimize the excess return over PPA Target 

Liabilities. 

 The “Percentage of Payroll” contribution policy 

in Asset & Funding Policies now allows a 

percentage that varies by calendar year. 

 

Sample Lives 

 In sample lives, you can now specify the 

maximum number of records to run (1-20).  For 

example, setting this to 1 along with a selection 

expression of “service>=30” will run the 

first record with at least 30 years of service. 

 A new Payment Form Value report is now 

available in pension modes (already available in 

OPEB mode). 

 The Active Decrements report now includes the 

Not-at-Risk and At-Risk decrements that 

underlie PPA Target Liabilities, making it easy 

to see which retirement age is used for At-Risk 

assumptions. 

Output & Reporting 

 Projected headcounts and benefits are now 

available in Valuation Output (previously only 

available in Execute > View).  This allows for 

comparing runs, adding runs and graphing.  For 

example, you might graph the projected benefits 

for a grouped valuation vs. a seriatim valuation 

to assess the fidelity of the data grouping. 

 

 Pre/post Medicare splits are now available for 

expected benefit payments in valuation and core 

projection output. 

 

 A summary of assumptions (i.e.,  inputs) for 

different sensitivities now appears in core 

projection output, making it easy to follow how 

each sensitivity is constructed. 

 

 Vested target liabilities are now calculated for 

Form 5500. 

Disclosure 

 Two benefit payment overrides can now be 

specified in your Asset & Funding Policy:  one 

for rolling liabilities forward to the measurement 

date and another for calculating the following 

year’s expense.  This facilitates calculating year-

end disclosure values for plans with a 
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measurement date other than the beginning of 

the plan year. 

Individual Results 

 A new individual result – Earliest Retirement 

Age – captures the age at which a participant 

first meets eligibility for any retirement benefit. 

Gain / Loss Analysis 

 Expected and actual benefit payments are now 

shown by status transition. 

 Gain / Loss Analysis can now be run over multi-

year periods (e.g., a 3 year period for triennial 

valuations) without requiring valuations in the 

intervening years. This is useful for Public and 

Canadian plans. 

 The "non-participating statuses" topic in Gain / 

Loss Analysis has been reworked to make it 

simpler to understand 

Experience Studies 

 The (exposed) headcount is now included when 

studying salary growth for continuing actives. 

 

Nondiscrimination Testing   

 Accrual Rates 

o For non-calendar plan years (e.g., year 

ending 6/30/2006), a new option lets you 

specify whether Social Security limits for 

calculating Covered Compensation and PIA 

are as of first day of the plan year (e.g., as of 

7/01/2005) or the calculation date (e.g., as of 

6/30/2006). 

 Coverage and General Tests 

o In the “Ratio percentage by rate group” 

table, failing rate groups are now flagged to 

make them easy to spot.  “*” marks those 

below the Ratio Percentage Test pass mark 

(generally 70%) and “**” marks those 

below the Nondiscriminatory Classification 

Test pass mark. 

 

o A new option lets you to treat negative 

accrual rates as zero (e.g., an integrated plan 

might produce artificially negative accrual 

rates for some participants when the 

integration level increases). 

o The adjusted normal and most valuable 

accrual rates are now available as individual 

results so you can see (and check) the effect 

of the permitted disparity adjustment. 

o The upper rate group can now be determined 

by looking at the maximum rate among 

HCEs, rather than all participants.  If so, 

NHCEs with greater rates will be lumped 

together in one “overflow” rate group. 

System 

 You can now print selected pages (e.g., 1-3,5), 

rather than having to print out every page of a 

long listing.  Also, you can now change the 

printer, orientation, paper, and copies without 

having to click the Setup… button. 
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Two Greenwich Office Park 
Greenwich, CT  06831 
 
tel:   (203) 861-5530 
fax:  (203) 861-5531 
email:  support@winklevoss.com 
website:  www.winklevoss.com 

 

 The client name (e.g., “ABC Demo”) has been 

moved from the status bar (bottom of window) 

to the caption (top of window).  In its place, the 

folder the client is saved in (e.g., 

“c:\...\abcdemo”) now appears in the status bar.  

This makes it easier to see which client is open 

and will hopefully prevent accidentally working 

with the wrong copy of a client (e.g., c:\ vs. g:\). 

 

 A checkmark on the Overrides button in 

valuation sets, deterministic forecasts, and 

stochastic forecasts, now makes it easy to see 

whether  or not liability overrides have been 

applied. 

 

 The ProVal installation procedure has been 

upgraded to: 

o Eliminate the need to manually install the 

“ProVal” font under Windows 2000. 

o Incorporate the sentinel driver installation, 

making it unnecessary to perform as a 

separate step. 

o Install shortcuts so that they are available to 

all users on a multi-user machine (e.g., 

under Windows XP). 

 The Batch Server interface has been enhanced to 

include end-user reporting, grant administrative 

rights, and more… 

For more information, see “Batch Server 

Installation Guide.pdf” in the ProVal folder. 

Changes Log 

 Be sure to read the changes log (see What’s New 

in Help or the CHANGES.LOG file in the 

ProVal directory) about updates to certain 

calculations that may change results. 

WinTech’s Virtual Back Office 

Need help bringing up new clients, 
converting cases, or experienced help in a 
ProVal area that’s new to you?  Why not call 
upon WinTech’s experienced actuaries to fill 

in?  Contact Hank Freeman at (203) 861-

5526 for details or to request a quote. 

New Member of the WinTech 
Team 

Sue Kalman recently joined the WinTech 

team.  Sue has used ProVal for nearly a 
dozen years and her testing skills are 
nothing short of legendary.  Sue has 35 
years of experience developing and testing 
in-house systems.  She’s also one of the 
nicest and most energetic people you’ll ever 
meet. 
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Data Screening 
Ever since valuations became a commodity in the marketplace, efficiency has been the name of the game.  To 

improve your efficiency, you can look for tasks that are responsible for a large percentage of a valuation’s time 

charges and streamline them.  Data processing is often such a task. 

Taking a closer look, the typical data processing tasks are: 

1. Import this year’s data 

2. Check some control totals (e.g., headcounts by status, total payroll) 

3. Screen the data for validity, reasonability, and completeness 

4. Default missing data and calculate valuation data 

The real time sink – and opportunity – is item #3.  ProVal’s new data screening tools are designed to seize this 

opportunity.  They put all the screening tools in one place and automate much of the process without losing the 

ability to customize it to your needs. 

ProVal’s data screening tools are available from the Database > Screen Data menu (or from within Spreadsheet 

Edit using the Screen menu). 

 

The first step in screening data is to Check for Duplicate Keys (e.g., Social Security Numbers).  Further 

screening steps presume that your data has unique keys.   If you have duplicate records that need to be combined, 

try using the new Condense Duplicates command on the Database menu. 

Once duplicate keys have been resolved, you’re ready to Screen Data. 
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To get started, you’ll need to provide the current year’s (and, if available, the prior year’s): 

 Database 

 Valuation date 

 Census Specifications 

That, along with key field(s), is all that’s needed to screen for: 

 Missing or invalid current year data (similar to the tests that are run when validating a valuation) 

 Unexpected changes from prior year 

 Status changes (hint:  start by pressing the “Populate” button) 

 Salary changes 

For completeness, we recommend that you also provide the current year’s plan definition and valuation 

assumptions, but this is optional. 

Tests which you don’t want to run (e.g., because they are not applicable to your plan) can be turned off.  In 

addition, all tests can be classified as either an error or warning; the distinction is purely for your use and has no 

intrinsic meaning to ProVal. 

For client-specific situations, you can also set up Custom Screening Tests.   

 

Custom screening tests combine the best of the “Compare Database Files” and “Screening Tests” commands 

found in previous versions of ProVal.  You can specify selection expressions, refer to fields in both the current 

and prior year’s databases, write complicated expressions, and save the tests for reuse later.  Custom screening 

tests can be set up within the Screen Data or Custom Screening Tests commands, but are always run from the 

Screen Data command. 

When you run the Screen Data command, it produces a summary of how many records failed each test and details 

for failed records.  All of the data that was used in each test is displayed (e.g., the key field, current year’s status, 

and prior year’s status) along with additional output fields that you choose (e.g., Name).  If desired, you can even 

customize the test descriptions.  The report can be easily saved to Excel for further manipulation before sending to 

your client for resolution. 
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Errors and warnings identified by the Check for Duplicate Keys and Screen Data commands can be written to the 

database’s error log by clicking Log Errors when viewing the output within these commands. 

To work with errors and warnings using the Spreadsheet Edit command: 

 Records with errors or warnings are highlighted with a yellow background.  For example: 

 

All fields involved in a failed test are highlighted. 

 On the View menu (within Spreadsheet Edit), click Select Errors to view only those records with errors 

or warnings.  This sets the selection expression to “#ERRORS” and evaluates it. 

 To see one cell’s errors and warnings, first select a cell.  Then, on the Screen menu (within Spreadsheet 

Edit), click Display errors for this cell.    

 To see all errors and warnings for the current database, click View Error Log on the Screen menu 

(within Spreadsheet Edit).  From here, you can print the list or save it to Excel.  You can also purge the 

error log of all or selected errors. 

Transition from 2.26 to 2.27 

The method for accomplishing many data screening tasks has been changed (for the better) in ProVal version 

2.27.  The most obvious change is that Database > Screen Data menu has been condensed. 
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ProVal 2.26 ProVal 2.27 

  

If you used this command in ProVal 2.26 Now use these commands in ProVal 2.27 

Compare Database Files 

 

The Screen Data command has many built-in tests 

that you may have previously been using Compare 

Database Files for (e.g., checking to see if the date 

of birth changed, checking for illogical status 

changes, etc.).  If the built-in tests are lacking 

anything, you can also set up Custom Screening 

Tests to compare values between the current year 

and a prior year database. 

Screening Tests The Custom Screening Tests library will be 

initialized with your previous Screening Tests.  

However, many of these tests should no longer be 

needed since they will be covered by the built-in 

tests found in the Screen Data command. 

Screen Data for Errors Custom Screening Tests are now run through the 

Screen Data command.  The Screen Data for Error 

library entries from 2.26 will not be carried over to 

version 2.27 since most of the 2.26 Screening 

Tests they contained will now be covered by the 

built-in tests found in the Screen Data command. 

Generate Error Report The output of the Screen Data command is meant 

to replace Generate Error Report to a large degree.  

It includes some of the features of 2.26’s Generate 

Error Report, including the ability to specify 

additional fields (e.g., Name and SSN) to appear 

in the listing.  Further manipulations can be 

performed by saving the output to Excel. 

Correct Errors Use the Spreadsheet Edit command. 
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On a related note, the following Database > Edit Data commands have been retired in version 2.27. 

If you used this command in ProVal 2.26 Now use these commands in ProVal 2.27 

Copy Fields You can create a copy of an existing field (except 

for character fields) by using Define Field by 

Expression.  Alternatively, in Spreadsheet Edit, 

use Edit > Add Fields and then copy and paste 

values from the old field into the new one. 

To delete the existing field (an option in 2.26’s 

Copy Fields command), use the Delete Fields 

command. 

Individual Record Edit Use the Spreadsheet Edit command with Records 

in Columns (on the View menu) to see all the data 

for a given record at a glance. 

 

Finally, the following pre-2.27 commands have been renamed in version 2.27. 

 Print Data has been renamed List Data.  It has also been moved to Database > Import / Export Data. 

 Create Fields has been renamed Add Fields. 

 Erase Fields has been renamed Delete Fields. 
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Core Projection Sample Lives 
With version 2.27, ProVal has the ability to display sample life results to help you verify your core projection 

results.  In general, the sample life tables are directly comparable to those available for valuations, albeit with 

“historical” information and valuation assumptions consistent with the core projection sensitivity.   

The initial core projection sample life dialog is 

comparable to valuations with respect to selecting 

records from the database and choosing the 

applicable valuation assumptions.  Unique to core 

projections, the data can be selected from either the 

current or the new entrant database file.  If from the 

latter, the year of hire must also be specified.  In 

either case, a selection expression and the process 

no more than x selected records control can be 

used to control the records processed.  Core 

projections also require specification of the desired 

sensitivity scenario, where the available choices 

are controlled by the Sensitivities button on the 

main Core Projection dialog. 

  

Once the sample lives have been run, the dialog of available choices is essentially the same as that for valuations 

except that there are a few extra choices: 

 Most tables depend on the valuation 

year to display, so for them a year 

must be chosen.  You will cycle 

through this dialog and the tables if 

you want to examine detailed results 

for more than one valuation year. 

 The tables distinguish between initial 

actives, emerging inactives and initial 

inactives.  Emerging inactive tables 

detail the inactive liability for 

participants that were active for the 

initial valuation year but then 

subsequently decremented and are 

inactive as of the “valuation year to 

display.” 

 There are two sets of active summary 

results tables:  standard and 

“normalized.”  The standard summary 

results table is designed to match the 

core projection results you would see 

under the output menu if you ran a single record with no scaling factors.  The results reflect the initial value of 

the Count field as well as the probability of survival to each future valuation date.   

The normalized summary results for active participants ignore these two items; they show the results as if 

100% of the person survived and remained active for each future valuation year.  These normalized tables 

allow you to see the relative value of liabilities as the participant ages and their service and salary increases. 
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As an example, the illustrations below are the summary results and normalized summary results for a single 

active record with a count field value of 5. 

 

 

Most of the sample life tables depend on the valuation year.  For example, the Benefit Definitions tables on the 

following page show the valuation year displayed after the record identifier.  Here, the participant entered the plan 

in 1996, the initial valuation year was 2007 and, in the first illustration, we are now in 2010.  All data shown 

through 2010 for the 2010 valuation year table is “experience data”, and all data shown after 2010 reflects the 

valuation assumptions.  As a comparison, the comparable table for the 2007 valuation year is also shown.  All of 

the differences between the two tables are attributable to differences between valuation assumptions and 

projection experience for the 2007 through 2009 plan years (if any). 
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Decrements 

For the initial valuation year, the decrements sample life table is identical to that shown for valuations.  

Specifically, it shows all valuation decrements beginning at entry age and continuing through the 100% retirement 

age.  For later valuation years, the decrements sample life table shows experience through the current valuation 

year and then valuation assumptions thereafter, so it spans only the period from the initial valuation year through 

the 100% retirement age. 

For example, in the table below, all decrement rates shown for years 2007 through 2009 are the experience 

decrements to which the participant was subjected.  The rates shown starting at 2010 are the valuation 

decrements.  There are also two columns unique to core projection sample lives (after the initial valuation year) 

which detail the experience survival probability to date and the experience survival discount. 
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Liability Details 

The sample life tables for the various liability methods are identical to the comparable valuation tables except, as 

shown below, for the addition of (1) identification of the valuation year and (2) adjustment of the calculation for 

the actual number of participants associated with the record.  Thus the bulk of the table develops the liability as if 

the record represented a single whole person (as is typically the case for a valuation), and then the results are 

multiplied by the number of people that that record actually represents, at the specified valuation date, to get the 

final liability.   An active liability table is shown below; the tables for inactive liabilities include comparable 

adjustments. 

 

Emerging Inactives 

The emerging inactive sample life tables for liability methods are quite different from anything available in 

valuations.  No emerging inactive liability tables are available for the initial valuation year, by definition, because 

no actives have yet decremented.  In later valuation years, a table will be available for each active benefit for each 
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participant who had met the eligibility requirements for a benefit during some valuation year prior to the year 

selected.  In the example below, RecID #2 did not meet that criteria, so a message was produced rather than a 

table.   

 

RecID #4, by contrast, was eligible for a benefit, and was assumed to partially decrement in each of the 2007 

through 2009 valuation years, and each of those decrements contributed to the 2010 emerging inactive liability for 

the benefit in question.  To detail this liability, the table generates the number of inactives and the liability amount 

as of 2010 associated with each past decrement, the total of which represents the total emerging inactive liability 

and the total inactive participant count associated with that benefit.   

For example, RecID #4 had a count of 2 participants age 58 in the initial 2007 valuation year with a retirement 

decrement probability of 4.97%.  Those decrementing actives had a 96.4% probability of surviving in inactive 

status to the 2010 valuation year, resulting in a total of .095924 inactives at 2010 from the 2007 retirement 

decrement for this record.  At decrement, the benefit (verifiable from the Benefit Definitions sample life tables) 

was $17,703.50. Since there is a 0% COLA assumption and the benefit is still in payment status (i.e., it was not a 

lump sum or a temporary annuity where the temporary period has expired), the benefit in 2010 is still $17,703.50.   

The payment form value at the valuation year will typically be the same regardless of the year of decrement 

because it will typically be an immediate annuity. In this example, however, the benefit is paid as a 3-year 

deferred annuity, so the values differ reflecting the differing current deferral periods. 

Note that these emerging inactive results can be verified by running a core projection with no new entrants and a 

single record.  The inactive results, available under the Output > Core Projection Output command and detailed 

by inactive status code, should match the Total column of the emerging inactive sample life tables. 

Plan Amendments 

Plan amendments can come into play during a core projection and have been addressed in the sample lives.  The 

information displayed depends on whether the valuation year is before, during or after the year of amendment.  

For example, the top illustration on the following page is an “amendment benefit”, the Benefit Definition to which 

a Benefit Definition in the Plan Definition will be amended during the forecast, for a valuation year prior to the 

amendment.  The Projected Benefit column is footnoted because it does not represent the results of the formula 

shown.  Rather, it equals the value of the associated pre-amendment definition. 
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In the year of amendment, both the pre- and post-amendment Benefit Definitions will have their Projected Benefit 

column asterisked.  In this year and all later years, the final projected benefit for the initial Benefit Definition will 

be coerced to reflect the post-amendment values.  (The details of this calculation are available by looking at the 

amendment Benefit Definition.)  The illustration below is of an original Benefit Definition on or after an 

amendment year. 
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In the amendment year(s) only, the projected benefit column of the amendment benefit will be coerced to equal 

the pre-amendment benefit.  The present value of this benefit will then be used in combination with the present 

value of the post-amendment benefit to determine the change in liability attributable to the amendment. 

For liability calculations, the amendment Benefit Definitions are only relevant in the year of an amendment.  In 

other years, a message such as that shown below will be displayed. 

 

In the amendment year(s), the present value of benefits and/or liability will be calculated for the amendment 

Benefit Definition and asterisked as illustrated below.  The projected benefit for this calculation (as noted on the 

Benefit Definition sample life table) is the pre-amendment benefit, so this calculation represents the pre-

amendment liability. 

   

New Entrants 

The sample life tables for new entrants are identical to those for initial actives except that they are only available 

for the period from the year of entry to the final valuation year.  One item unique to new entrants that you can 

examine in these tables is the input data versus the age and salary of the new entrants as they enter during the 

forecast.  You should note that the entry age for the new entrant remains constant regardless of the year of entry, 

and the salary at hire increases from the input data by the experience salary inflation assumption (but not the merit 

scale).   
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Note that it is not possible to display the “actual” number of new entrants for the forecast because that would 

require a complete forecast of the initial actives versus the population growth assumption to determine the number 

required new entrants each year, a process that is beyond the scope of the sample lives.  Accordingly, regardless 

of the number of new entrant records selected in the selection expression, the total count for the sample lives will 

be “normalized” at 1. Thus, if the initial count field for each record is 1 and you run 2 records through the sample 

lives, each record will have a sample life count of 0.5.  If you run three records with an initial count field of 1, 

each will have a count of 0.3333.  If the initial count field is other than 1, such as 0.3 for a 25 year old and 0.1 for 

a 50 year old and these two records are both selected, the sample life count will be normalized per the count field 

to 1, so the count for the 25 year old will be 0.75 and the count for the 50 year old will be 0.25. 

Available Tables 

Generally speaking, all of the valuation sample life tables are available in core projections, plus there are some 

special core projection sample life tables for emerging inactives.  There are some exceptions, however.  For 

example, the pension payment form values and maximum current liability tables available for valuation sample 

lives are not (at least currently) available in core projection sample lives.   

There are some other types of tables that we have thought of (and probably many that we have not thought of!) 

that seem desirable for core projection sample lives but are not currently available.  One example is a table 

detailing experience benefit payments.  Another example is a single table that develops the valuation salary for all 

valuation years.  These tables will be added as time, competing priorities and user demand indicate. 
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Canadian Solvency Liability 
The Canadian mode solvency liability may now be split into two pieces: a “transfer value” (sometimes referred to 

outside of ProVal as “commuted value”) portion and an “annuity purchase” portion.  There are separate interest 

rates and, potentially, mortality assumptions for these two pieces of liability.  The annuity purchase portion may 

be further refined by specifying a deferred annuity purchase interest rate different from the immediate annuity 

purchase interest rate. 

To accommodate the enhanced solvency valuation assumptions, two new Solvency Liability subtopics have been 

introduced to replace the single Solvency Liability topic that existed previously:  “Solvency Interest Rates” and 

“Mortality and Optimal Value”. 

The solvency liability may be calculated using solely the transfer value assumptions; or, alternatively, a separate 

annuity purchase liability may be calculated. This annuity purchase liability may have distinct interest rate 

assumptions for immediate and deferred annuities.    
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The transfer value interest rate assumption is variable by duration from the valuation date, and is input as forward 

rates.  Typically there will be one rate for 15 years and another rate thereafter.  The annuity purchase interest rates 

(if applicable) are entered as constants. 

When annuity purchase interest rates differ from the transfer value rates, a separate annuity purchase liability is 

calculated.  In this case: 

 Active participants who meet conditions specified by the user (e.g. age 55) will be valued using the 

immediate annuity purchase interest rate.  In the absence of a deferred annuity rate (see below), actives 

not meeting the eligibility conditions for the annuity purchase rate will be valued under the transfer value 

liability.   

 Inactives currently in receipt of benefits will automatically be valued using the specified immediate 

annuity purchase interest rate assumption.  A participant will be deemed to be “in receipt” if any of their 

benefits are annuities that have already commenced (or are about to commence).  Decrementing actives 

are deemed to be in receipt when they are assumed to have decremented with an annuity.   

 Inactives not currently in receipt will be valued using the immediate annuity purchase rate if they are 

over a user-specified age.   

 Distinct assumptions for deferred versus immediate annuities may be specified. 

If a separate annuity purchase liability is calculated and a value other than 0% is entered for the active and/or 

inactive proportion of participants to be valued using a deferred annuity purchase rate, you will be able to enter 

a deferred annuity purchase rate distinct from the immediate annuity purchase rate.  In this case: 

 A user-specified percent (x) of active participants who do not meet the eligibility conditions specified for 

inclusion in the immediate annuity purchase calculation, will be valued using the deferred annuity 

purchase rate.  The remaining (1-x)% of active participants not meeting the immediate annuity purchase 

conditions are valued using the transfer value assumptions.   

 A user-specified percent (y) of inactive participants not in receipt and not over the specified age for 

inclusion in the immediate annuity purchase liability, will be valued using the deferred annuity purchase 

rate.  The remaining (1-y)% of inactive participants not meeting the immediate annuity purchase 

conditions are valued using the transfer value assumptions.   

On the Mortality and Optimal Value dialog, the annuity purchase and transfer value liability mortality 

assumptions are the same unless the user specifies otherwise.  The default mortality table is the UP-1994 

Projected to 2015 with Projection Scale AA, which is now a standard ProVal table.  Note that the dialog no longer 

has a direct option for “zero pre-election mortality” because this valuation assumption can now be achieved 

within the Mortality Table Library, by defining a mortality table with distinct pre- and post-commencement 

mortality assumptions, where the pre-commencement assumptions are zero. 

Other than the interest and mortality assumptions, the rest of the Solvency Liability calculation remains 

conceptually unchanged.  Specifically, the optimal value age is calculated on an aggregate basis and applied 

uniformly to the three pieces (transfer value, immediate annuity and deferred annuity) of the liability.  
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Transition to New Structure 

If you edit old valuation assumptions that have a calendar year solvency interest rate assumption, ProVal will 

make an attempt at converting to duration-based rates and produce a message that it did so.  If you don’t like 

ProVal’s conversion, you may of course change it (or cancel). 

Internally, ProVal considers any existing solvency liability results to be annuity purchase results and will display 

blank transfer value results.  For new runs, if you do not specify distinct annuity purchase assumptions, then there 

will be a single liability and it will be considered a solvency transfer value liability.  If you specify distinct 

annuity purchase assumptions, then your results will contain both transfer value and annuity purchase pieces of 

the liability and, as described below, you will be able to forecast your results using distinct interest rate 

assumptions. 

Sample Lives 

There is still only one “Solvency” checkbox, but within the sample life pop-up menu, there are now three sample 

life table choices for each benefit: transfer value, deferred annuity purchase, and immediate annuity purchase.  

The Optimal Value age asterisk will appear at the same age for all three tables. 

Deterministic Forecasts 

There are now two columns in Deterministic Assumptions to specify future valuation interest rates for the 

solvency liability: Change in Solvency Transfer Value Rate and Solvency Annuity Purchase Rate.   

For the transfer value portion of the solvency liability, deterministic forecast interest rates are specified as deltas, 

or plus or minus changes from the baseline interest rate (i.e., forward rate) curve.  This moves the entire interest 

rate curve up or down in a parallel fashion.  Thus, for a typical assumption that breaks at 15 years, a specification 

of +0.01 increase both the pre- and post-15 year duration rate by 1%. 

For the annuity purchase portion of the solvency liability, the deterministic forecast interest rates are specified as 

the desired immediate annuity purchase interest rate.  The deferred annuity purchase rate, if applicable, is 

determined proportionate to the change in the immediate annuity rate.   
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Stochastic Forecasts 

Stochastic assumptions for the solvency liability are specified as shown below.  If the assumptions vary during the 

forecast (as they should), the transfer value moves in a parallel fashion with changes in the specified benchmark 

yield, either a government or a corporate bond yield.  For this calculation, a year 0 benchmark yield is required 

as the starting point and must be specified.   

The annuity purchase interest rates also vary with the (same) specified benchmark yield, but in this case they are 

simply the simulated yield plus the specified target rate spread over benchmark.   

The other parameters, which allow adjustment for semi-annual compounding, a maximum absolute change per 

year, rounding, and minimum and maximum rates, are unchanged from the prior version of ProVal. 
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Solvency Amortization Rate 

For a Valuation Set or forecast calculations, the funding rules require a solvency interest rate to determine the 

solvency assets, which (generally) include the present value of any amortization payments scheduled for the 5-

year period beginning with the valuation date.  For this purpose, ProVal uses the solvency amortization rate 

specified in the Asset & Funding Policy, and appropriately adjusted during a forecast, if provided.   

If a user-specified solvency amortization rate is not provided, the “solvency liability discount rate” is determined 

in accordance with the following rules: 

 “Old runs”, which, by definition, used either static or calendar year rates, are characterized by ProVal as 

annuity purchase only, so the annuity purchase rate (the only rate) is used. 

 New runs that don’t calculate a separate annuity purchase liability are characterized as transfer value only, 

so the transfer value rate (the only rate) is used. 

 New runs that have both a transfer value liability and an annuity purchase liability use the transfer value 

rates as the solvency amortization rate. 

Consistency Requirements in a Valuation Set or Forecast 

If a user-specified solvency amortization rate is provided in the Asset & Funding Policy, then valuations may be 

combined in a Valuation Set irrespective of inconsistent solvency interest rate assumptions.  For Valuation Sets 

for which a user-specified solvency amortization rate is not provided, “old runs” may not be mixed with new runs. 

That is, valuations using a duration-based interest rate assumption may not be combined with valuations having 

either calendar year or static interest rate assumptions.   

For forecasts, all of the core projections must have the same solvency interest rate type, irrespective of whether a 

separate solvency amortization rate is specified.  For a forecast, and also for a Valuation Set without a specified 

amortization rate, all of the interest rate assumptions must be consistent.  Specifically, all of the transfer value 

interest rate assumptions must be the same, all of the immediate annuity purchase interest rate assumptions (if 

applicable) must be the same, and all of the deferred annuity purchase interest rate assumptions (if applicable) 

must be the same. 
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